ANALISE ESTATICA LINEAR DE UM PUXADOR USANDO O ABAQUS 6.12
STUDENT EDITION

1. INTRODUCAO

1.1.DESCRICAO DO PROBLEMA:

Neste exemplo vamos analisar um puxador, feito de aco, submetido a
um carregamento estatico. Puxadores de ago sdo utilizados em uma grande
variedade de objetos. Neste exemplo vamos assumir que o puxador em
questdo € um dos puxadores usados para levantar um vaso depressao,
conforme mostra a figura 1. Além disso, assume-se que o puxador esta
devidamente soldado ao vaso de pressdao. De acordo com o0 American
Petrolium Institute Standard 650, puxadores de tanques de petrdleo devem ser
capazes de resistir a carga, aplicada de uma maneira razoavel, de duas vezes
0 peso do tanque vazio, usando-se o fator de seguranca 4. O objetivo da nossa
andlise é entdo determinar a maxima carga que pode ser aplicada no puxador
para que nao ocorra plastificacdo na peca. Pode-se considerar a fixacdo da

solda como engaste perfeito em nosso modelo.

1.2. PROPRIEDADES GEOMETRICAS

As dimensodes do puxador séo:

h=0,127m
b=0,0762 m
d =0,0508 m
t =0,00254 m

J& que a espessura € pequena e 0 carregamento € vertical, pode-se

assumir que se trata de um problema plano de tensdes.
1.3.PROPRIEDADES DOS MATERIAIS

O material € assumido como elastico linear com Modulo de Young

E=0.2.10'? Pa, com tens&o limite de escoamento Sy = 0.25.10° e coeficiente de



Poisson n = 0,25. Assume-se também que a carga total esta aplicada em uma

regido de 30° em torno do eixo vertical.

Figura 1. Esquema do vaso com o puxador
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Figura 2. Esquema do puxador a ser analisado



2. RESOLUCAO

O procedimento de resolucdo pode ser demonstrado no seguinte
fluxograma (a ordem pode eventualmente ser quebrada em pontos especificos

por conveniéncia):



PRE-PROCESSAMENTO

Inicio da Analise

Criagdo da geometria base (Parts)

Definir Tipo de Elementos

Atribuicdo das propriedades dos
materiais (Materials)

Atribuicdo das propriedades das
sec¢oes das barras (Sections)

Associa¢do das SecOes, geometria
base, materiais... (Section
Assignments) (Assembly)

Aplicar¢ao das condigoes de
contorno

Cargas (Loads)

Apoios (BCs)

Criagdo da geometria da malha
(Mesh)

Elementos calculaveis pelo
método dos elementos finitos.
Aproximagdo da estrutura real.

_IDefinigﬁo das Variaveis de Sal'daI

(Field Output Requests)

PROCESSAMENTO

Solugdo, Calculos
Computacionais (Jobs)

POS-PROCESSAMENTO

Andlise dos resultados

Variavéis de saida

Analise grafica




1.1.INICIO DA ANALISE

v' Se vocé ainda nao iniciou o programa Abaqus/CAE, cmd no
Menu Iniciar para abrir o Prompt de Comando e nele
abg6122se cae para executar o Abaqus.

v" Em Create Model Database na caixa Start Session que aparece,

With Standard/Explicit Model.

1.2.PRE-PROCESSAMENTO
v No menu Model a esquerda, com o botdo direito em Model-1 e
Rename. AnalisePuxador.

v No menu Model a esquerda, dé duplo clique em Parts, no campo Name

Puxador, e as opcgoes: 2D Planar, Deformable, Shell.
Em approximate size 1. em Continue...
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4 em Create Lines: Rectangle (4 lines) na caixa de ferramentas e
as seguintes coordenadas 0,0 — 0.0762,0.0889.
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v' Na caixa de ferramentas, cligue em Create Circle: Center and

Perimeter, selecione o ponto médio da aresta superior e cligue em um

dos vértices dessa aresta. Clique novamente no ponto medio da aresta
e entdo digite 0.0127,0.0889. Tecle enter.
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v" Na caixa de ferramentas, clioue em Auto-trim e apague todas as linhas
indesejadas, conforme mostra a imagem a seguir. Entdo desative a

funcdo Auto-Trim e clique em Done.
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v No menu Model a esquerda, dé duplo cligue em Materials. Na janela
Edit Material renomeie o material para Aco ASTM A36, selecione
Mechanical>Elasticity>Elastic e digite 0.2E12 em Young’s Modulus

e 0.25 em Poisson’s Ratio. Selecione Mechanical>Plasticity>Plastic

e digite 0.25E9 em Yield Stress e 0 em Plastic Strain. Cligue em OK.
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v No menu Model a esquerda, dé duplo cligue em Sections. No campo
Name: digite Secdo Puxador, em Category selecione Solid, e em

Type selecione Homogeneous. Clique em Continue... Na janela Edit




Section, Marque Plane Stress/strain thickness: e digite 0.5. Clique
em OK.
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‘ A nev nodel databaze has been created
| 5 | Toe"nodel " kcdei-1" bas been crosted
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v No menu Model a esquerda, abra Parts>Puxador e dé duplo clique em
Section Assignments. Selecione o puxador e cligue em Done.
Selecione Segéo Puxador e cligue em OK.
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v" No menu Model a esquerda, abra Assembly, dé duplo cligue em

Instances e clique em OK na janela Create Instance.
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v No menu model a esquerda, dé duplo cligue em Steps. Digite

i

Model

Carregamento no campo Name: e Clique em Continue....
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Tuer moael daiabaze has been cravied
The model “Hodel-1' has been created
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v" Na janela Edit Step selecione a Aba Incrementation. Digite 1000 em

Maximum number of increments e 0.001 em Increment size:>Initial,

Minimum e Maximum. Clique em OK.
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v' Na barra de contexto, em Module, selecione Part. Na caixa de
ferramentas, clique e segure o botdo esquerdo em Partition Edge:
Specify Parameter by Location, e escolha a opgédo Partition Edge:
Enter Parameter. Selecione o perimetro do furo da peca e clique em

Done. Digite 0.666667 e cligue em Create Partition. Repita

selecionando a parte menor do perimetro e digitando 0.5. Clique em
OK.
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v" No menu model a esquerda, dé¢ duplo clique em Loads. Na janela
Create Load, no campo Name digite Carga Genérica, (roque o Step



para Carregamento, em Types for Selected Step selecione Pressure

e cligue em Continue....

[8 Fie Model Viewpon Yiew Lesd BC PredefincdFiekl lgadCase Festye Took Puugeins Help AT Bl =

DTResd OFO - e LHUEA LM ReCESBREOF (0®m oK) ¢ REi By s Hf-
s | wosie [Tiows ] wote Fainrwaer 5] s [Fcommpmrnte [
¥ @m
] «E
=@
WD
&k [
& 2 Conte Load ]
o o ey
Bl P —
.nu; Procedure: Static, General
i 4 o e
24, @ Mechanicsl Concenrated force
s
Ba Mesh Empty)

@5 Matenals 1) i

& Caorsbons

L comem Susaam

b

5 4§ Assembly

% ofh Steps 12) l

&5 Fieid Output Requests (1)

Contins. Cancel
L =

e T

et
o
€ “llsers\Gustavch-Drophox WET000 D05 ELENENTOS FINITOS\AULA § pular por enqua
C lzer e tns aveh-Dronbon ETO00 Dog ELENENTOS FINITOSALA & buist box saua
el Fr op bk METOD0 D08 ELEMENTUS ETRITOS\AULA 8 palar por sAquantoiauls b oficis

v' Selecione a regido de aplicagao da for¢a e cligue em Done. Na janela
Edit Load, digite 1E8 no campo Magnitude: e cligue em Create
Amplitude. (atencdo: A tensdo utilizada deve ser ligeiramente maior que
0 valor esperado para que o processamento dos dados ndo seja

interferido pela plasticidade da peca)
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v Na janela Create Amplitude aceite Tabular em Type clicando em

Continue... Logo abrira a janela Create Amplitude. Digite 0 e 0 na



linha 1 e digite 1 e 1 na linha 2. Cligue em OK, selecione a amplitude

criada e novamente cligue OK.
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v No menu model a esquerda, d¢ duplo cligue em BCs. Na janela Create
Boundary Condition, altere o campo Name para Engaste, Step para
Initial e Types for Selected Step para  Symetry/
antisymmetry/Encastre. Cligue em Continue... Selecione a aresta
inferior do puxador e cligue em Done. Marque ENCASTRE (Ul = U2 =
U3 = UR1 = UR2 = UR3 = 0) na janela Edit Boundary Condition e

cligue em OK.
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v Na barra de contexto, em Module, selecione Mesh, e em Object,
selecione Part. Na barra do menu principal, cliqgue em Mesh>Element

Type e selecione o puxador. Clicando em Done, abrirh a janela

Element Type. Em Family, selecione Plane Stress, em Geometric
Order,
Integration. Cligue em OK.
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v Na barra do menu principal, clique em Seed>Part, digite 0.006 em
Approximate global size e cligue em Apply. Analise a distribuicdo dos

pontos e cligue em Done.
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v Na barra do menu principal, clique em Mesh>Part. Aparecera a

pergunta “OK to mesh the part?”, clique Yes. Perceba que a placa fica

na cor azul.
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v No menu model a esquerda, abra History Output Requests (1), clique
com o botéo direito em H-Output-1, entdo selecione a opcdo delete...

Cligue em Yes.

1.3.PROCESSAMENTO

v" No menu model a esquerda, d& duplo cligue em Jobs e clique em
Continue... Clique em OK.

v Abra Jobs (1), cligue com o botdo direito em Job-1 e cligue em
Submit. Nas janelas que se abrem, cligue em OK e Yes. Clique com o
botdo direito do mouse em Job-1 (Running) e selecione Monitor.
Perceba como estdo sendo feitos os incrementos de tempo no

processamento.



T I =
| Job: Job-1 Status: Completed
|
| o e e o e em s e
1 901 1 0 1 1 0991 0991 0.001
1 992 1 0 1 1 0992 0992 0001
1 993 1 0 1 1 0993 0993 0.001
1 994 1 0 1 1 0994 0994 0.001
1 995 1 0 1 1 0995 0995 0.001
1 996 1 0 1 1 099 09% 0.001
1 997 1 0 1 1 0997 0997 0.001
1 908 1 0 1 1 0998 0998 0.001
1 999 1 0 1 1 0999 0999 0.001 I
1 1000 1 0 1 1 1 1 0.001 -
| Leg |/ Emors || Wamings | Output | Data File | Message File | StatusFile

Search Text
Te:rttofind:| | Match case [l Mext {f Previous

1.4.POS-PROCESSAMENTO

v No menu model a esquerda, cligue com o botdo direito em
Jobs(1)>Job-1 (Completed)>Results. A tela de analise de dados se
abrird. Na caixa de ferramentas, cligue em Plot Contours on
Deformed Shape.

v Na barra de menus principal, cligue em Viewport>Viewport
Annotation Options.... Na janela aberta, selecione a aba Legend.
Cligue em Set Font. Na nova janela, altere Size para 14. Cligue OK

nas duas janelas abertas.
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v" Na barra de menu principal, clique em Animate>Time History. Veja o
gue acontece com o puxador a medida que a tensdo aplicada aumenta.

Na barra de contexto, cligue em Frame Selector.
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v Na barra de ferramentas no canto superior a direita, selecione AC
YIELD. Perceba através da ferramenta Frame Selector, que apds o
590° incremento (59,0% da pressao estipulada no pré-processamento) a
tensdo de escoamento é atingida, e passa a existir regides de regime

plastico no puxador.
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v" Na barra de menu principal, cligue em Report>Field Output. Na janela
Report Field Output, cligue em S: Stress Components > Mises, Max.
In-Plane Principal, S11, S22, S12 e em AC YIELD: Active yield flag.
Cligue em Step/Frame e na janela que se abre selecione o incremento
590. Cligue em OK nas duas janelas. A mensagem aparecera: “The field
output report was appended to file “abaqus.rpt”.” O arquivo abaqus.rpt

pode ser encontrado em C:\Users\"Nome do Usuario”\abaqus.rpt.
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; ::'::a,(m Step: 1. Carregaments
B o 8 Frame: 590 Step/Frame..
B imoges o Varable | Setup
¥ +06 Output bies.
£ Step/Frame 3 |
Step tame Descrption |

v W S Stress components
) Mses
] Max. In-Plane Principst

Increment 583 Sep Tene =
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| abaqus.rpt - Notepad .- —— — = 5| |
FEile Edit Format View Help
0DB: C:/Users/GustavoN/Job-1.odb
Step: Carregamento
Frame: Increment 590: step Time =  0.5900
Loc 1 : Integration point values from source 1
lloutput sorted by column "Element Label”.
leield output reported at integration points for part: PUXADOR-1
|
AC YIELD s.Mises S.Max. In-P s.511 5.522 5.512
@Loc 1 @oc 1 @Loc 1 @Loc 1 @Loc 1 @Loc 1
|
- -
I
Minimum 0. 6.24526E+06 -6B. 6566E+06 -180.383e+06 -79.6781E+06 -99.174BE+06
I AT Element 244 100 27 27 23 101
fl Int Pt a H 4 1 2 1
Bl maximum 0. 249.677E+06 252.254E+06 221.783e+06 232.737E+06 92.4637E+06
AT Element 244 102 102 136 102 24
i Int Pt a 9 a 9 8 1
: Total 0. 92.5046E+09 71.4350E+09 989.446E+06 49, 4401E+09 -3.87785E+09
i
|

v" Na barra do menu principal,

em File>Save As.... um nome ao

arquivo e em OK (E possivel também salvar o arquivo com os

resultados ja calculados - job-1.0db).

1.5.RESULTADO

v Como descobrimos que o Ultimo incremento no regime totalmente

elastico linear foi o 590° (0.590), temos:

1 =100% -------- (Load>pressure) 100.000.000 Pa
0,590 = 59,0% --------
X =100.000.000 * 0,59 = 59.000.000 = 59*10° = 59 MPa

X

Area de Aplicacdo = 0.00254*[(2*pi*0.0254)/6] = 6.75609972*10° m?

Forca = Pressdo * Area = 59*10° * 6.75609972*10™

Forca = 3986,1 N




